Note
Before you use this information and the product it supports, read the information in "Notices" on page 27.

This edition applies to version _1_, release _1_, modification _1_ of IBM Network Performance Insight and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 2015, 2016.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Configuring integrations with other products ........................................ v
Intended audience ............................................................................. v
Organization ................................................................................... v
Network Performance Insight overview ........................................... v
Service Management Connect ........................................................ vii
Network Performance Insight technical training .............................. vii
Support information .......................................................................... vii
Conventions used in this publication ................................................ viii
Typeface conventions ................................................................... viii

Chapter 1. Integrating ............................................................... 1
Integrating with IBM Tivoli Network Manager .................................. 2
Prerequisites ...................................................................................... 3
Deployment considerations ............................................................... 3
Software requirements and dependencies ......................................... 4

Chapter 2. Planning your deployment ........................................... 5
Installing Network Manager ............................................................ 5
Quick reference to Tivoli Network Manager installation ..................... 5
Configuring Tivoli/Netcool OMNibus ................................................ 7
Quick reference to Tivoli Netcool/OMNibus configuration ..................... 7
Starting an ObjectServer ................................................................... 9
Stopping an ObjectServer ................................................................. 10
Quick reference to integration .......................................................... 11
Logging in to the Dashboard Application Services Hub portal .............. 11
Configuring thresholds .................................................................... 13

Chapter 3. Configuring integration with Tivoli Network Manager ...... 15
Configuring NCIM database connectivity ........................................... 15

Chapter 4. Configuring integration with Tivoli Netcool/OMNibus ...... 17
Configuring launch-in-context integration with Network Performance Insight ...................................................... 17
Creating a launch-in-context tool ....................................................... 17
Configuring launch-in-context menu ................................................ 18
(Optional) Sending Network Performance Insight Threshold Events to OMNibus ................................................... 19
Configuring the OMNibus Standard Input probe to work with Network Performance Insight ........................................ 20
Encrypting Object Server password .................................................. 22
Changing ObjectServer user password .............................................. 22

Chapter 5. Troubleshooting integrations ..................................... 25

Notices .............................................................................................. 27
Trademarks ......................................................................................... 29
Terms and conditions for product documentation .......................... 30

© Copyright IBM Corp. 2015, 2016
Configuring integrations with other products

How to integrate IBM® Network Performance Insight with other components of IBM Netcool® Operations Insight.

You can set up Network Performance Insight to work with other IBM Netcool Operations Insight products. Read the necessary configuration tasks required to set up the available integrations.

Intended audience

The audience who are network administrator or operations specialist responsible for installing the Network Performance Insight product suite on an enterprise network.

To integrate Network Performance Insight with successfully, you must have a thorough understanding of the following subjects:

- Network Performance Insight 1.1.1 system
- Basic principles of network protocols and network management
- Flow concepts
- Network discoveries by using IBM Tivoli® Network Manager
- Fault management capabilities of IBM Tivoli Netcool/OMNIbus
- Jazz™ for Service Management 1.1.2.1

Organization

Read this summary to help you find the information that you need.

- Chapter 1, “Integrating,” on page 1
- Chapter 2, “Planning your deployment,” on page 5
- Chapter 3, “Configuring integration with Tivoli Network Manager,” on page 15
- Chapter 4, “Configuring integration with Tivoli Netcool/OMNIbus,” on page 17
- Chapter 5, “Troubleshooting integrations,” on page 25

Network Performance Insight overview

IBM Network Performance Insight is a flow-based network traffic performance monitoring system.

Network Performance Insight provides comprehensive, flexible, and scalable traffic data management with visualization and reporting to support complex, multi-vendor, multi-technology networks. It offers a range of dashboard views with robust security features that are designed to meet the needs of executive management and converging network and IT operations teams.

Network Performance Insight offers near real-time and interactive view on the traffic data that helps in reduced network repair times and optimized network performance.
Network Performance Insight provides IBM Netcool Operations Insight with network performance monitoring capabilities to address modern network management challenges around application-oriented, software-defined-networks in the enterprise data centers and intranet.

The following diagram shows how data is flowing through the various components in Network Performance Insight:

The flow records that are sent by the configured flow exporters are collected by Collector, and sent to Inventory or Analytics component based on the information that they contain.

Analytics component performs flow data aggregation. These results are then stored in Network Performance Insight database.

Additionally, you can enable or disable the processing of flow records on each flow interface on Dashboard Application Services Hub portal. The dashboards provide up-to-date actionable information to provide an insight into network problems and streamline root cause analysis.

The data from the Storage component can be queried to display the results on Network Health Dashboard or OMNIbus Web GUI from Active Event List or Event Viewer.

You must integrate Network Performance Insight with IBM Tivoli Network Manager and Tivoli Netcool/OMNIbus components of IBM Netcool Operations Insight to take advantage of its network topology views and fault management capabilities.

Network Performance Insight includes the following documents:

- Release summary
• Quick Start Guide
• Installing Network Performance Insight
• Configuring Network Performance Insight
• Integrating with Netcool Operations Insight
• Getting Started with Network Performance Insight
• Troubleshooting Network Performance Insight
• References
• Technical notes

**Related information:**

[IBM Network Performance Insight on IBM Knowledge Center]

---

**Service Management Connect**

Connect, learn, and share with Service Management professionals: product support technical experts who provide their perspectives and expertise.


• Become involved with transparent development, an ongoing, open engagement between other users and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product roadmaps, and prerelease code.
• Connect one-on-one with the experts to collaborate and network about Tivoli and the Network and Service Assurance community.
• Read blogs to benefit from the expertise and experience of others.
• Use wikis and forums to collaborate with the broader user community.

**Related information:**

[IBM Network Performance Insight community on developerWorks]

---

**Network Performance Insight technical training**

For Tivoli technical training information, see the following Network Performance Insight Training website at [https://tnpmsupport.persistentsys.com/updated_trainings](https://tnpmsupport.persistentsys.com/updated_trainings)

---

**Support information**

If you have a problem with your IBM Software, you want to resolve it quickly. IBM provides the following ways for you to obtain the support you need:

**Online**


**IBM Support Assistant**

The IBM Support Assistant is a free local software serviceability workbench that helps you resolve questions and problems with IBM Software products. The Support Assistant provides quick access to support-related information and serviceability tools for problem determination. To install the Support Assistant software, go to [http://www.ibm.com/software/support/isa](http://www.ibm.com/software/support/isa)
Troubleshooting Guide
For more information about resolving problems, see the problem determination information for this product.

Conventions used in this publication
Several conventions are used in this publication for special terms, actions, commands, and paths that are dependent on your operating system.

Typeface conventions
This publication uses the following typeface conventions:

**Bold**
- Lowercase commands and mixed case commands that are otherwise difficult to distinguish from surrounding text
- Interface controls (check boxes, push buttons, radio buttons, spin buttons, fields, folders, icons, list boxes, items inside list boxes, multicolored lists, containers, menu choices, menu names, tabs, property sheets), labels (such as Tip:, and Operating system considerations:)
- Keywords and parameters in text

*Italic*
- Citations (examples: titles of publications, diskettes, and CDs)
- Words defined in text (example: a nonswitched line is called a point-to-point line)
- Emphasis of words and letters (words as words example: "Use the word that to introduce a restrictive clause."); letters as letters example: "The LUN address must start with the letter L.")
- New terms in text (except in a definition list): a view is a frame in a workspace that contains data.
- Variables and values you must provide: ... where myname represents....

**Monospace**
- Examples and code examples
- File names, programming keywords, and other elements that are difficult to distinguish from surrounding text
- Message text and prompts addressed to the user
- Text that the user must type
- Values for arguments or command options

**Bold monospace**
- Command names, and names of macros and utilities that you can type as commands
- Environment variable names in text
- Keywords
- Parameter names in text: API structure parameters, command parameters and arguments, and configuration parameters
- Process names
- Registry variable names in text
- Script names
Chapter 1. Integrating

Integration of IBM Network Performance Insight with IBM Netcool Operations Insight v1.4.

Network Performance Insight integrates with the following components of Netcool Operations Insight:

**IBM Tivoli Network Manager**

Tivoli Network Manager provides features that are required to manage complex networks. These features include network discovery, device polling, including storage of polled SNMP and ICMP data for reporting and analysis, and topology visualization. In addition, Network Manager can display network events, perform root-cause analysis of network events, and enrich network events with topology and other network data.

The Network Manager architecture can be divided into three layers: network layer, data layer, and visualization layer.

Topology data is stored in the Network Connectivity and Inventory Model (NCIM) database. Traffic Details dashboards use the topology data from NCIM database for enriching the flow data. The NCIM database is a relational database that consolidates topology data discovered by Network Manager.

Network administrators query the NCIM database to programmatically retrieve topology information. Administrators can support topology enrichment from third-party data sources by adding tables and fields to the topology database.

**IBM Tivoli Netcool/OMNIbus**

IBM Netcool Operations Insight uses real-time alarm and alert analytics, which are combined with broader historic data analytics.

Tivoli Netcool/OMNIbus tracks alert information in a high-performance, in-memory database, and presents information of interest to specific users through filters and views that can be configured individually. Tivoli Netcool/OMNIbus has automation functions that can perform intelligent processing on managed alerts.

Components of Tivoli Netcool/OMNIbus:

- ObjectServer
- Probes
- Gateways
- Desktop tools
- Administration tools
- Web GUI

**Related information:**

- [Network Manager architecture](#)
- [Topology storage architecture](#)
- [Introduction to Tivoli Netcool/OMNIbus](#)
Integrating with IBM Tivoli Network Manager

How to integrate IBM Network Performance Insight with Tivoli Network Manager component of IBM Netcool Operations Insight.

Provides step-by-step instructions on how to integrate Network Performance Insight with Tivoli Network Manager.

**Important:** Before you install and use Network Performance Insight, read the *IBM Network Performance Insight: Release Summary*. The *Release Summary* can contain information specific to your installation that might not apply to your non-default setup. Failure to consult the *Release Summary* might result in a corrupted, incomplete, or failed installation and integration.

A bird’s-eye-view of the tasks that are needed for the integration of Network Performance Insight with IBM Tivoli Network Manager and IBM Tivoli Netcool/OMNIbus components. This diagram shows the steps that are needed for installation, configuration, and integration of Network Performance Insight with Network Manager, and OMNIbus components. These steps are needed for visualization of traffic data from Network Health Dashboard and Tivoli Netcool/OMNIbus Web GUI. These steps in the diagram do not depict the order in which they must be performed.

**Install/Upgrade**
- Tivoli Network Manager (ITNM) components
- Network Health Dashboard (NHD)
- Network Performance Insight (NPI)
- Jazz for Service Management

**Configure**
- ITNM GUI
  - Configure network discoveries
  - Setup network for visualizations
- NHD
  - Configure Network Health Dashboard
  - Create custom dashboards
- DASH
  - Configure launch-in-context Tool on DASH
  - Configure launch-in-context Menu on DASH
- NPI
  - Editing default settings (npi.conf)
  - Configure NCIM connectivity (npi.conf)
  - Add the NPI Traffic Details dashboard widget to NHD
  - Configure thresholds on DASH
  - Configure STDIN probe (npi.conf)
- DASH
  - Configure DASH communications (npi.conf)
  - Configure Interfaces
  - Configure Retention profiles
  - Configure Domain names
  - Configure console integration

**Integrate**
- NPI
- NIID
- NPI

**Troubleshoot**
- Known issues in IBM Knowledge Center
  - Review log files
  - Contact IBM Support
- Known issues in IBM Knowledge Center
  - Review log files
  - Contact IBM Support
Prerequisites

Ensure that you fulfill the prerequisites for integrating Network Performance Insight with Tivoli Network Manager and Tivoli Netcool/OMNIbus.

The most up-to-date information about supported hardware, software, browsers, and operating systems is provided by the IBM Software Product Compatibility Reports website.

Related information:
- Hardware requirements for Tivoli Network Manager
- Software requirements for Tivoli Network Manager
- Planning for installation or upgrade Tivoli Netcool/OMNIbus

Deployment considerations

Network Performance Insight is supported as a stand-alone single-server installation. But its integrated components exist in a distributed installation setup.

Install the following Network Manager components:

Network Manager core components
This component consists of the core Network Manager processes: network discovery, polling, root cause analysis, and event enrichment.

NCIM database
This database stores topology data.

Tivoli Netcool/OMNIbus
This component consists of the Tivoli Netcool/OMNIbus event management software that includes the Object Server and Tivoli Netcool/OMNIbus Web GUI.

Network Manager GUI components
This component includes the Dashboard Application Services Hub GUI framework, Web GUI components, Jazz for Service Management, and Java.

Other components
IBM Networks for Operations Insight. Networks for Operations Insight adds network management capabilities to the Netcool Operations Insight solution. The Networks for Operations Insight capability is provided through setting up the following products in Netcool Operations Insight:

- Network Manager
  A main feature that is provided by Networks for Operations Insight is the Network Health Dashboard. Network Health Dashboard is only available if you have Network Manager as part of Netcool Operations Insight.
- Netcool Configuration Manager

Note: Network Performance Insight 1.1.1 does not integrate with this component.

Related information:
- IBM Networks for Operations Insight
Software requirements and dependencies

Ensure that you have all of the required software before you start the integration.

Ensure that the following software is available:

- IBM Network Performance Insight, Version 1.1.1
- IBM Tivoli Network Manager V4.2.0
- IBM Tivoli Netcool/OMNibus v8.1 for Netcool Operations Insight V1.4, Fix Pack 5
- IBM Tivoli Netcool/OMNibus Web GUI v8.1 for Netcool Operations Insight V1.4, Fix Pack 4
- Dashboard Application Services Hub on Jazz for Service Management, V1.1.2.1

IBM Tivoli Netcool/OMNibus Web GUI uses a client/server architecture and it is hosted inside Dashboard Application Services Hub, which is part of Jazz for Service Management. Clients connect to Dashboard Application Services Hub to access the Web GUI.

Related information:

- Jazz for Service Management Detailed System Requirements
- Supported products and components in Netcool Operations Insight 1.4
Chapter 2. Planning your deployment

Steps to start Network Performance Insight environment.

Procedure
1. Install Tivoli Netcool/OMNibus.
2. Install Jazz for Service Management.
3. Install Tivoli Netcool/OMNibus Web GUI.
4. Install Tivoli Network Manager and all its components.
5. Install Network Health Dashboard.
8. Configure single sign-on on Jazz for Service Management.
9. Create users and assign roles.
10. Configure SSL on Jazz for Service Management.
11. Configure NCIM database connectivity.
12. Configure the OMNibus Standard Input probe to work with Network Performance Insight.

Installing Network Manager

Describes installation and configurations that are needed on the IBM Tivoli Network Manager server and IBM Tivoli Netcool/OMNibus that are required for integrating with Network Performance Insight.

Quick reference to Tivoli Network Manager installation

Use this information as a quick reference if you are new to Tivoli Network Manager and want to perform an installation and configuration.

The following table lists the high-level steps for installing Tivoli Network Manager.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read about deployment considerations and system requirements for Network Manager.</td>
<td>Planning for installation</td>
</tr>
<tr>
<td>Before you install Network Manager, you must complete extra tasks, depending on your environment.</td>
<td>Preparing to install</td>
</tr>
</tbody>
</table>
Table 1. Quick reference for installing Tivoli Network Manager (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Install the prerequisites, associated products, and components of Network Manager in the order that they are presented here. | Installing Network Manager and related components:  
• Installing and configuring IBM Installation Manager  
• Installing and configuring a topology database  
• Installing and configuring Tivoli Netcool/OMNIbus  
• Installing the Network Manager core components  
• Installing WebSphere Application Server  
• Installing Dashboard Application Services Hub  
• Installing Tivoli Netcool/OMNIbus Web GUI  
  - Planning for installation or upgrade  
  - Installing and updating the Web GUI component  
  - Gathering installation information  
  - Installing the Web GUI  
• Installing the Network Health Dashboard  
• Installing the Network Manager GUI components  
• Optional: Installing Reporting Services  
• Optional: Installing Network Manager reports  
  **Note:** The optional components are not required for working with Network Performance Insight. |
| After you install Network Manager, you need to perform some postinstallation tasks. | Postinstallation tasks |
| Optional: If your installation fails for some reason, use the IBM Installation Manager to remove or roll back the product to previous version.  
  **Note:** Uninstallation of the product by removing files and directories can cause problems when you reinstall.  
You must uninstall the products and components in the order that is specified. | Uninstalling Network Manager |
| You can install fix packs, and roll back to a previous version by using IBM Installation Manager. | Installing and uninstalling fix packs |

**Related information:**

- Installing Tivoli Network Manager on IBM Knowledge Center
Quick reference to Network Manager configuration

Perform these basic steps to configure Network Manager after the installation is complete. You can then use the system.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra configuration tasks on UNIX systems.</td>
<td>Configuring Network Manager for UNIX operating systems</td>
</tr>
<tr>
<td>Change the appearance and functionality of the Hop Views; update MIB information; and configure the presentation of events from unmanaged devices.</td>
<td>Configuring GUIs</td>
</tr>
<tr>
<td>If you change the IP address and hostname of the server where any of the components of Network Manager or integrated products are installed, you must configure Network Manager and associated components and products.</td>
<td>Changing the IP address and hostname of the Network Manager installation</td>
</tr>
<tr>
<td>Set the appropriate environment variables by running the environment scripts.</td>
<td>Setting environment variables</td>
</tr>
</tbody>
</table>

Related information:

- Configuring Network Manager

Configuring Tivoli/Netcool OMNIbus

These are the configurations that are needed on the Tivoli Netcool/OMNIbus server and Tivoli Netcool/OMNIbus Web GUI.

Quick reference to Tivoli Netcool/OMNIbus configuration

Use this information as a quick reference if you are new to Tivoli Netcool/OMNIbus and want to install and configure to obtain a running ObjectServer.

The following table lists the high-level steps for installing Tivoli Netcool/OMNIbus.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If necessary, set the following environment variables:</td>
<td></td>
</tr>
<tr>
<td>• $NCHOME</td>
<td>By default, /opt/IBM/tivoli/netcool</td>
</tr>
<tr>
<td>• $OMNIHOME</td>
<td>By default, $NCHOME/omnibus</td>
</tr>
<tr>
<td>• $PATH</td>
<td>By default, $NCHOME/omnibus/bin</td>
</tr>
<tr>
<td>• Solaris $LD_LIBRARY_PATH</td>
<td>By default, /opt/IBM/tivoli/netcool/platform/</td>
</tr>
<tr>
<td>• AIX $LIBPATH</td>
<td>By default, /opt/IBM/tivoli/netcool/platform/</td>
</tr>
<tr>
<td>Note: &lt;arch&gt; refers to the operating system.</td>
<td></td>
</tr>
<tr>
<td>Create an ObjectServer by running the database initialization utility as follows:</td>
<td></td>
</tr>
<tr>
<td>UNIX $NCHOME/omnibus/bin/nco_dbinit -server servername</td>
<td></td>
</tr>
<tr>
<td>Linux $NCHOME/omnibus/bin/nco_dbinit -server servername</td>
<td></td>
</tr>
<tr>
<td>Where servername is the ObjectServer name, which must consist of 29 or fewer uppercase letters and cannot begin with an integer.</td>
<td></td>
</tr>
<tr>
<td>The default database tables and data, users, groups, roles, and properties file are created. (You can use the default user root, which is created with a blank password, to log in to the ObjectServer).</td>
<td></td>
</tr>
<tr>
<td>Note: To update the root password, see &quot;Changing ObjectServer user password&quot; on page 22</td>
<td></td>
</tr>
<tr>
<td>Configure server communication information for the ObjectServer on the host computer.</td>
<td></td>
</tr>
<tr>
<td>UNIX $NCHOME/bin/nco_igen</td>
<td></td>
</tr>
<tr>
<td>Linux $NCHOME/bin/nco_igen</td>
<td></td>
</tr>
<tr>
<td>The interfaces file $NCHOME/etc/interfaces.arch is created, where arch represents the operating system name.</td>
<td></td>
</tr>
<tr>
<td>Note: The example entries in the communication details use the default host name omnihost. Change this host to the name of the computer on which each server is run.</td>
<td></td>
</tr>
</tbody>
</table>

---

**Table 2. Quick reference for installing Tivoli Netcool/OMNIbus**
Table 2. Quick reference for installing Tivoli Netcool/OMNIbus (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start the ObjectServer by running the following command:</td>
<td>&quot;Starting an ObjectServer&quot;</td>
</tr>
<tr>
<td>-UNIX: $NCHOME/omnibus/bin/nco_objserv -name servername</td>
<td></td>
</tr>
<tr>
<td>-Linux:</td>
<td></td>
</tr>
<tr>
<td>Prepare to install the Web GUI by checking the prerequisites, deciding on the type of installation that is required, and gathering the required information.</td>
<td>Planning for installation or upgrade</td>
</tr>
<tr>
<td>Installing and updating the Web GUI component</td>
<td></td>
</tr>
<tr>
<td>Gathering installation information</td>
<td></td>
</tr>
<tr>
<td>Configure the required user registry, for example LDAP, against the Dashboard Application Services Hub installation.</td>
<td>Configuring user authentication</td>
</tr>
</tbody>
</table>

Starting an ObjectServer

You must have an ObjectServer running before you can use the components of Tivoli Netcool/OMNIbus.

About this task

You can start an ObjectServer:

- Automatically, using process control on UNIX
  By starting the process agent when the system starts, you can make the ObjectServer start automatically on UNIX.
- Manually, from the command line

Procedure

- To start an ObjectServer as a process, enter the following command:
  `nco_pa_start -process ObjectServer`

  **Note:** You can start the ObjectServer from a remote computer. The name that you specify with the `-server` option is compared to the process agent names that are configured in the Server Editor. The host computer and port are identified and the command is sent to the correct process agent. For example, `nco_pa_start -process NCOMS -server test.ibm.com:50000`.
- Use the `nco_objserv` command to start the ObjectServer manually. Use the following command:
  `$NCHOME/omnibus/bin/nco_objserv [ -name servername ]`

  In this command, `servername` is the ObjectServer name. If you do not specify the `-name` command-line option, `nco_objserv` attempts to start the NCOMS ObjectServer. You can start the ObjectServer with extra command-line options.

  **Note:** An ObjectServer that is started from the command line is not under process control, and must be restarted manually if it is shut down.
On start, the ObjectServer attempts to open the $NCHOME/omnibus/etc/
servername.props properties file, where servername is the name of the specified
ObjectServer. For example, NCOMS.props.

Related information:

Starting an ObjectServer

Stopping an ObjectServer

On both UNIX, an ObjectServer can be stopped, as a process, by using the process
agent. The ObjectServer must be defined as a process or part of a service. You can
also stop an ObjectServer from the SQL interactive interface.

About this task

You can stop an ObjectServer:

• Automatically, using process control on UNIX by using the process agent. The
  ObjectServer must be defined as a process.
• From the SQL interactive interface.
  If you manually started an ObjectServer from the command-line, you must
  manually stop the ObjectServer by using the SQL interactive interface. You must
  have the appropriate permissions to stop the ObjectServer.

Procedure

1. To stop an ObjectServer as a process, enter the following command:
   nco_pa_stop -process ObjectServer
   a. To stop the ObjectServer from a remote computer, enter the following
      command:
      nco_pa_stop -server NAME_PA -process <ObjectServer>

      Where <ObjectName> is NCOMS
      In this example, NAME_PA value that you specify with the -server option is
      compared to the process agent names that are configured in the Server
      Editor. The host machine and port are identified, and the command is sent
      to the correct process agent on a remote computer.

2. Stop an ObjectServer that was started manually as follows:
   a. Connect to an ObjectServer by running the appropriate command for your
      operating system:
      $NCHOME/omnibus/bin/nco_sql [ -server servername ] [ -user username ]
   b. Provide the requested password.
   c. When the SQL prompt is displayed, enter the following commands:
      1> alter system shutdown;
      2> go

      The nco_sql command does not allow white space that is preceding the go
      keyword. Any white space causes the SQL statements to fail.

Related information:

Stopping an ObjectServer
Quick reference to integration

Use this information as a quick reference if you are new to Tivoli Netcool/OMNIbus and want to install from scratch.

The following table lists the high-level steps for installing and configuring the integration components.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Network Performance Insight by using IBM Installation Manager.</td>
<td>Installing IBM Network Performance Insight, Version 1.1.1</td>
</tr>
<tr>
<td>Prepare for the installation by checking the prerequisites.</td>
<td>Checking prerequisites</td>
</tr>
<tr>
<td>Install IBM Tivoli Netcool/OMNIbus and Jazz for Service Management</td>
<td>Fix central</td>
</tr>
<tr>
<td>Install the Tivoli Netcool/OMNIbus core components. Apply Fix Pack 5. Associated tasks include creating and starting ObjectServers.</td>
<td>Installing Tivoli Netcool/OMNIbus Creating and running ObjectServers</td>
</tr>
<tr>
<td>Install the Tivoli Netcool/OMNIbus Web GUI V8.1. Apply Fix Pack 4. <strong>Note</strong>: Installation Manager V1.8.2.1 or later is required before Web GUI V8.1 Fix Pack 4 installation.</td>
<td>Installing Dashboard Application Services Hub and the UI components</td>
</tr>
<tr>
<td>Configure the Web GUI for integration with Network Performance Insight.</td>
<td>&quot;Configuring launch-in-context integration with Network Performance Insight&quot; on page 17</td>
</tr>
<tr>
<td>Monitor events from Web GUI.</td>
<td>See Monitoring events from Web GUI on Dashboard Application Services Hub in Getting started with Network Performance Insight.</td>
</tr>
</tbody>
</table>

Logging in to the Dashboard Application Services Hub portal

Depending upon your organization’s deployment, you can access the reporting interface through Dashboard Application Services Hub.

**Procedure**

- Access the reporting interface from Dashboard Application Services Hub as follows:

  1. Open a web browser and enter the following URL for the Jazz™ for Service Management UI and reporting server:
     https://host.domain:port/DASH_context_root
     For example: https://<myserver.ibm.com>:16311.ibm/console
     Where:
-- host.domain is the fully qualified host name or IP address of the Jazz for Service Management UI and reporting server.

When single sign-on (SSO) is enabled, ensure that you use the fully qualified host name in the URL of the Jazz for Service Management reporting and UI server. SSO requires that the browser pass LTPA cookies to the Jazz for Service Management application server, and these cookies contain the fully qualified host name.

-- port is the secure HTTP port number that was specified during installation. The default value is 16311.

-- /DASH_context_root is the context root for the console that was specified during installation. The default value is /ibm/console.

2. Enter the user ID and password in the Dashboard Application Services Hub login page. Click Log in.

The Dashboard Application Services Hub Welcome page opens.

3.

Note: Console Integration icon is available only after you complete the task Configuring Network Performance Insight console integration on Jazz for Service Management that is available in Configuring Network Performance Insight.

Click Console Integration icon ( ) on the navigation bar and select the dashboard of your choice under System Configuration.

- Click Incident ( ) on the navigation bar and select Network Health Dashboard under Network Availability.

Configuring Network Performance Insight console integration on Jazz for Service Management

To display external content from a stand-alone console in the Dashboard Application Services Hub console, you can configure a new console integration.

Before you begin

Make sure that all these components of Jazz for Service Management are installed:
- IBM Dashboard Application Services Hub
- Administration Services
- Administrative Services UI
- Security Services
- Registry Services

Note: If the Security Services are not installed, you might encounter an Authentication Service client error with the following message ID: CTGES0039E

Procedure

1. Log in to Jazz for Service Management server as an administrator user. See “Logging in to the Dashboard Application Services Hub portal” on page 11.

2. Click Console Settings > Console Integrations in the navigation bar.

A Console Integrations page is displayed, and existing console integrations (if any) are listed in a table.
3. Click the **New** icon on the taskbar.
   The Console Integrations configuration page is displayed.

4. Required: Provide a meaningful name in the **Console Integration Name** field for the console integration that you are creating.
   For example, *NPI Console*.
   This name is visible to all the users on Dashboard Application Services Hub portal as a folder on the main menu.

5. Enter a URL for the content in the **Console Integration URL** field that you want to display in the Dashboard Application Services Hub console.
   For example, `https://<myserver.mydomain.com>:9443/Blaze/rest <myserver.mydomain.com>` is the fully qualified server name where Network Performance Insight is installed.

   **Note:** When you specify a URL, you must provide a fully qualified URL that includes `https://` and a full host DNS name for SSO to work correctly.

6. Click **Test Connection** to test the connection for the URL that you entered.
   If the connection is unsuccessful, try to restart Network Performance Insight system. It might take sometime to see successful connection.
   For successful connections, a table lists the tasks available from stand-alone console and attributes for each task.

7. Click **Save** to commit your settings. The new console integration is added to the list in the **Console Integrations** page.

8. Close the **Console Integrations** page.

**Results**

If the connection test was successful, the specified stand-alone console content is available in the navigation bar of the Dashboard Application Services Hub console through the icon.

**Related information:**

[Stand-alone console content integration](#)

### Configuring thresholds

Thresholds provide a mechanism for identifying anomalies in flow data. In this release, thresholds are applied to the total traffic on a flow interface. Threshold is a metric value that is compared against a value to determine whether an interface violated a specific constraint.

**About this task**

These thresholds are considered static thresholds because you set the value for them by using the configuration dialog box. You also define how you want the threshold to act.

**Procedure**

1. Log in to Jazz for Service Management server.

2. Click **Console Integrations** in the navigation bar and select **Thresholds** under **System Configuration**.
You can see Flow Thresholds table.

3. Select a row from the table and click the Edit ( ) button to configure a Threshold for an Interface. Enter the following details:
   a. Select the **Enabled** check box to enable a Threshold on the Interface.
   b. Select the **Limit Type** list to **Over**, **Under**, or **Band**.
      - **Over** Detect violations when they exceed threshold values.
      - **Under** Detect violations when they fall short of threshold values.
      - **Band** Detect violations when they go outside a range (or band) between two threshold values.
   c. Enter the **Upper Limit** for the traffic flow for triggering the Threshold.
   d. Enter the **Lower Limit** for the traffic flow for triggering the Threshold.
   e. Enter the number of events for triggering the Threshold.

   **Note:** When the threshold violation limit is crossed, it displays the severity as **Critical**.
   For more information, see **Threshold levels** in **Network Performance Insight overview**.

4. Click and type an Interface in the **Filter by Domain Name** field. You can view the details of that particular entity.

5. Perform the following tasks in the **Actions** column:
   a. Click **Edit** to edit or configure the selected Threshold. Repeat step 3
   b. Click **Enable** or **Disable** to enable or disable the Threshold for an entity.
   c. Click **Traffic Details** to view the Traffic Details for an entity.

6. Click **OK** to save the settings.

7. Select a number to change the number of items in the table. Click the arrow to go to a particular page.
   In the lower-right corner, the numbers that are displayed are the number of interfaces to be displayed on each page.

8. Enter a page number that you want to navigate in the Go to Page, and click Go.

**Results**

Any interface that is violating the new threshold value is reported in the Active Event List and Event Viewer.

**What to do next**

You must repeat the same process to enable and configure Thresholds for every Interface as needed.

**Note:** Currently, you cannot select multiple interfaces to configure the thresholds values at a time.
Chapter 3. Configuring integration with Tivoli Network Manager

Explains the tasks that are associated with integrating Network Performance Insight with the Tivoli Network Manager.

About this task

You can see the Traffic Details dashboard widget from Network Health Dashboard on Dashboard Application Services Hub.

Configuring NCIM database connectivity

This configuration helps to federate IBM Tivoli Network Manager NCIM Topology database that can be hosted on Oracle or IBM DB2 database into Network Performance Insight storage.

Before you begin

Make sure that the following conditions are met before you connect the NCIM database:

- Install and configure the latest version of Tivoli Network Manager.
- Install either IBM DB2 or Oracle database to host the NCIM topology database, configure an instance, and create a database before Network Manager is installed.
- Install the Network Manager. During installation, the NCIM topology database is installed on the database that you created in the previous step.
- Your Oracle or DB2 instance is up and running.
- A compatible JDBC driver to connect to IBM DB2 database for Tivoli Network Manager is used.
  For more information, see [DB2 JDBC Driver Versions and Downloads](#).
- Oracle ojdbc6-11gR2.jar that is available in the `<NPI_Home>/lib` directory is used.

About this task

Modify the Network Performance Insight `npi.conf` configuration file in `<NPI_Home>/conf` folder. You can use the template file `npi-itnm.template` that is available in `<NPI_Home>/conf` folder.

Procedure

1. Open the `npi.conf` file from `<NPI_Home>/conf` folder.
2. Add the following settings for NCIM database connectivity:
   ```
   itnm.host = "<myserver.ibm.com>"
   itnm.platform = "database-platform-type"
   itnm.port = <database_port_number>
   itnm.username = "<user_name>"
   itnm.password = "<password>"
   itnm.database = "NCIM"
   ```
Where:

Table 3. Configurations for NCIM database connectivity

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>itnm.host</td>
<td>Hostname where Tivoli Network Manager is running.</td>
<td>&lt;myserver.ibm.com&gt;</td>
</tr>
<tr>
<td>itnm.platform</td>
<td>Supported database for NCIM</td>
<td>DB2, Oracle</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, it is DB2.</td>
<td></td>
</tr>
<tr>
<td>itnm.port</td>
<td>Port number where NCIM database is running.</td>
<td>Typical default values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="1521" /> 50000</td>
</tr>
<tr>
<td>itnm.username</td>
<td>Valid user name that is used to log in to NCIM database.</td>
<td>db2inst1 or oracle based on the database that NCIM is supported on.</td>
</tr>
<tr>
<td>itnm.password</td>
<td>Valid password to log in to NCIM database.</td>
<td>Based on the database that NCIM is supported on:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="db2inst1" /></td>
</tr>
<tr>
<td>itnm.database</td>
<td>Tivoli Network Manager topology database</td>
<td>NCIM</td>
</tr>
</tbody>
</table>
Chapter 4. Configuring integration with Tivoli Netcool/OMNIbus

Explains the tasks that are associated with integrating Network Performance Insight with the Tivoli Netcool/OMNIbus Web GUI application. The Tivoli Netcool/OMNIbus Web GUI customizable dashboards display real-time performance information and event data.

About this task

An event contains the Event ID, host name, and port information. When an event is selected, some of the data for the event is sent to Network Performance Insight and used to determine the best report to present. Network Performance Insight then builds a block of HTML content that redirects the browser to a Network Performance Insight display.

Right-click an event in Active Event List or Event Viewer of Web GUI to display the tools that are added from the alerts menu. You select an option from this menu to display a detailed Network Performance Insight report for the time period of the threshold violation or an AEL report.

Configuring launch-in-context integration with Network Performance Insight

Launch-in-context integrations are supported between the Web GUI and compatible Tivoli products. A launch-out integration describes the starting of another product from a Web GUI widget. A launch-in integration describes the starting of the Web GUI from another product.

About this task

Launch-in-context is the concept of moving seamlessly from one Tivoli product UI to another Tivoli product UI (either in a different console or in the same console or portal interface) with single sign-on and with the target UI in position at the proper point for users to continue with their task.

Related information:

Creating a launch-in-context tool

You can create tools that are run from right-click menus in event lists or when users click a widget. Different tool formats are supported.

Procedure

1. Log in to Jazz for Service Management server as an administrator user, such as npiadmin.
2. Select Administration > Event Management Tools > Tool Configuration from the left pane.
3. Click Create Tool and enter the following details:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>npiFlowTvLiC</td>
</tr>
<tr>
<td>Type</td>
<td>script</td>
</tr>
<tr>
<td>Script Commands</td>
<td>Copy and paste the contents of the file npiFlowTvLiC.js that is available in &lt;NPI_home&gt;/resources/webgui. Where, &lt;&lt;NPI_home&gt;&gt; is Network Performance Insight installation directory.</td>
</tr>
</tbody>
</table>

4. Select the data source name OMNIBUS.
5. Clear the **Execute for each selected row** check box.
6. Click **Save**.
   - A confirmation message is displayed. Click **OK** to close the message.

**Related information:**

Tools overview

Configuring launch-in-context menu

In event lists, users access default and custom tools through menus. You can add tool entries to the menus, create new submenus, and modify or delete menu items.

**About this task**

The two supplied menus are the **Alerts** menu and the **Tools** menu. The **Alerts** menu can also be opened from the right-click menu when you select an event.

**Procedure**

1. Log in to Jazz for Service Management server as npiadmin user.
2. Select **Administration > Event Management Tools > Menu Configuration** from the left pane.
3. Select the **alerts** menu in the window, and then click the **Modify** button. The **Menus Editor** is displayed.
4. Select the npiFlowTvLiC tool in the **Available items** on the left, click the arrow to move it to the **Current items** section.
5. Select npiFlowTvLiC from the **Current items** section and click **Rename**.
6. In the **Label** text box, enter a meaningful name for the new button.
   - For example, Flow Dashboard. If needed, enter a value in the **Mnemonic** text box, if needed.
7. Click **Save**.
8. Use the button selections on the left to move the menu option up or down.
   - Separators might also be added by selecting **<Separator>** in the **Available Items** area of the window. The separator might be moved up and down.
9. Click **Save**.
   - The following message is displayed:
     - **Menu has been successfully modified.**
10. Click **OK** to close the message.
Results

When you right-click any event in Active Event List, you can see the npiflowTvLiC tool that is renamed to Flow Dashboard as a selectable option in the menu. Select the tool to see the Traffic Details report associated with the interface that violated the threshold and generated the event.

(Optional) Sending Network Performance Insight Threshold Events to OMNibus

You can edit the information that is contained in the properties files for ObjectServers. A properties file has a .props extension. ObjectServer properties file is NCOMS.props.

About this task

Note: NCOM is the default name for an ObjectServer instance.

Procedure

Important: These steps are required if you are using REST API for event management and not required if you are using STDIN probe.

For more information, see Configuring the OMNibus REST APIs in Network Performance Insight in Configuring Network Performance Insight.

1. From the Conductor window on UNIX, click Properties in the button bar. The Properties Editor window opens.
2. From Type list, select ObjectServer to edit the properties files of components such as ObjectServers and proxy servers.
   Typically, these files are available in <NCHOME>\omnibus\etc directory.
4. Edit the NCOMS.props file to add the following settings:
   
   NHttpd.EnableHTTP: TRUE
   NHttpd.ListeningPort: 8080
   NRestOS.Enable: TRUE

5. Restart the ObjectServer.

What to do next

Verify the ObjectServer is providing the REST API with a curl command to get all active alerts. Follow these steps:

- curl --basic --user USERNAME:PASSWORD http://NODENAME:PORT/objectserver/restapi/alerts/status

Specify appropriate values for NODENAME, PORT, USERNAME, and PASSWORD

You can see an output in JSON format as follows:
Related information:

Starting the Conductor

Configuring the OMNIbus Standard Input probe to work with Network Performance Insight

Modify the Network Performance Insight npi.conf configuration file in `<NPI_Home>/conf` folder.

Before you begin

- Configure the host name resolution to resolve omnihost to the actual host name where Tivoli Netcool/OMNIbus is installed. Add an alias entry in the `/etc/hosts` file as follows:

  `<IP_Address> <fully_qualified_host_name> <alias>`

  For example,

  `192.0.2.0 <myserver.ibm.com> omnihost`

- Ensure that you have the following 32-bit Linux operating system libraries.

  - lib32z1
  - lib32ncurses5
  - lib32bz2-1.0
  - libstdc++6
  - lib32stdc++6

  **Note:** The Standard Input probe is a 32-bit application and requires some 32-bit libraries to work on a 64-bit environment.

About this task

The Standard Input probe is bundled with Network Performance Insight and is installed along with it. This probe works with minimal or no configuration.
settings. If you want to change the ready for immediate deployment settings, you can change the following settings by using the template file npi-noi.template that is available in \(<NPI\_Home>/conf folder:

**Note:** Change or add these settings only when recommended by IBM Support Professional.

**Procedure**
1. Open the npi.conf file from \(<NPI\_Home>/conf folder.
2. Add the following setting for Tivoli Netcool/OMNIbus Standard Input (STDIN) probe to send events to OMNIbus:
   ```
   event.netcool.home = "\(<netcool\_installation\_directory>\)"
   event.netcool.omnibus.home = "\(<omnibus\_installation\_directory>\)"
   event.netcool.omnibus.temp = "\(<temp\_directory\_for\_log\_files>\)"
   event.netcool.omnibus.stdin.args = "\(<additional\_probe\_command\_line\_args>\)"
   event.netcool.omnibus.stdin.props = "\(<omnibus\_stdin\_probe\_properties\_file\_location>\)"
   event.netcool.omnibus.stdin.rules = "\(<omnibus\_stdin\_probe\_rules\_file\_location>\)"
   ```

   Where

   **Table 4. Configurations for OMNIbus REST APIs**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>event.netcool.home</td>
<td>Root installation directory for your Netcool products</td>
<td>NCHOME</td>
</tr>
<tr>
<td>event.netcool.omnibus.home</td>
<td>Root OMNIbus Installation directory</td>
<td>NCHOME/omnibus</td>
</tr>
<tr>
<td>event.netcool.omnibus.temp</td>
<td>Temp directory where the log files are located</td>
<td>(&lt;NPI_HOME&gt;/probe/omnibus/var</td>
</tr>
<tr>
<td>event.netcool.omnibus.stdin.args</td>
<td>You can configure the STDIN probe to log at other levels (for ex, DEBUG), and to a different log location by specifying this setting in the npi.conf file. Anything that is specified in this setting is passed directly on the command line to the STDIN probe at startup.</td>
<td>-messagelevel INFO -messagelog /var/tmp/stdin.probe.DEBUG.log Or -messagelevel DEBUG -raw</td>
</tr>
<tr>
<td>event.netcool.omnibus.stdin.props</td>
<td>STDIN probe properties file location</td>
<td>(&lt;NPI_HOME&gt;/probe/omnibus/probes/linux2x86/stdin.props</td>
</tr>
<tr>
<td>event.netcool.omnibus.stdin.rules</td>
<td>STDIN probe rules file location</td>
<td>(&lt;NPI_HOME&gt;/probe/omnibus/probes/linux2x86/stdin.rules</td>
</tr>
</tbody>
</table>

   **Note:** By default, the Event Service processor that starts the STDIN probe configures the probe to log to the /opt/IBM/NPI/probe/omnibus/var/stdin.probe.log file.
Encrypting Object Server password

Decide which level of security that you require and perform the configuration tasks that are required for that security level. Some configuration tasks are required, while others are required only for specific levels of protection. It is a good security practice to encrypt passwords that are used.

About this task

Encrypt the passwords that are created for Jazz for Service Management and also for Tivoli Netcool/OMNibus components.

Procedure

1. To create an encrypted password, use the bin/encrypt utility that is available in Network Performance Insight.
   Use the following command:
   $ bin/encrypt <test_pass>
   You can see the encrypted password as:
   fe/KSX5GZ+/gjCkKwGbIHlQ==

2. Copy the encrypted password in the configuration settings in np1.conf file as follows:

   security.dash.port=16311
   event.netcool.omnibus.rest-api.host="<myserver.ibm.com>"
   event.netcool.omnibus.rest-api.port="8080"
   event.netcool.omnibus.rest-api.path="/objectserver/restapi/alerts/status"
   event.netcool.omnibus.rest-api.username="root"
   event.netcool.omnibus.rest-api.password="fe/KSX5GZ+/gjCkKwGbIHlQ=="
   event.netcool.omnibus.rest-api.realm="omnibus"


   Note: Check the Event Service log message in np1.log file for successful encryption. All the configuration settings must have values.

Changing ObjectServer user password

Instructions to set or change ObjectServer user password.

About this task

You must run the nco_config utility to start Netcool/OMNibus Administrator by using the following command:

$NCHOME/omnibus/bin/nco_config

Procedure

1. From the Netcool/OMNibus Administrator window, select File > Import.
2. Click Next.
3. Import the ObjectServer (NCOMS) and click Finish.
4. In the Netcool/OMNibus Administrator window, right-click the ObjectServer (NCOMS) and click Connect as.
5. Enter the user name as root and password.
   By default, the password is left blank.
6. Click OK.
7. From the Netcool/OMNibus Administrator window, select User.
8. Click **Users**.
   The Users pane opens.
9. To edit the root user, select root user to edit and then click **Edit User** in the toolbar.
   The User Details window opens.
10. Click **Settings > Change**.
11. Enter a new password and click **Save**.

**What to do next**

If the password of the user that authenticates the connection between the ObjectServer and the Web GUI is changed, update the password on the Web GUI server. For more information about setting the password for Web GUI, see [Changing the password for the connection to the ObjectServer](#).
Chapter 5. Troubleshooting integrations

Problems that might occur during integration of Network Performance Insight with Tivoli Network Manager and how to resolve them.

About this task

For all troubleshooting issues, see Troubleshooting Network Performance Insight.
Notices

This information was developed for products and services offered in the US. This material might be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. Actual results may vary.

The client examples cited are presented for illustrative purposes only. Actual performance results may vary depending on specific configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to actual people or business enterprises is entirely coincidental.

COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright notice as follows:

© (your company name) (year).
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_.

# Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at "Copyright and trademark information" at [www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).

Adobe, Acrobat, PostScript and all Adobe-based trademarks are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of The Minister for the Cabinet Office, and is registered in the U.S. Patent and Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other countries.
Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium, and the Ultrium logo are trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary notices are preserved. You may not distribute, display or make derivative work of these publications, or any portion thereof, without the express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, distribute or display these publications or any portion thereof outside your enterprise, without the express consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either express or implied, to the publications or any information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the publications is detrimental to its interest or, as determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.